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ReggieNet: Communication Workshop 

Facilitators: Mayuko Nakamura (mnakamu), Charles Bristow (cebrist),  
Linda Summer (lsummer) & Steve Travers (sttrave) 

 Forums 

Before you start 

FORUM: A Forum is a collection of topics that the instructor has created.  In each Forum, you can have a 
number of topics.  Access to the entire Forum can be controlled through the forum settings. 

TOPIC: A topic is a collection of one or more conversations (threads) that users have created because 
they have questions, want to make comments, need to reply, etc.  Inside a Topic, you click on an 
individual Conversation to see what people have posted. Access to the topic can be controlled through 
the topic settings. 

CONVERSATION:  Conversations are threads made up of posts between individual users.  

POST: Posts are comments uploaded by users.  A group of linked Posts is called a Conversation. 
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Setting up and Managing Forums 

Creating a Forum 

1. If the Forums home page is not displayed, click FORUMS in the breadcrumb bar. 
2. Click the New Forum tab near the top of the screen. The Forum Settings screen will be 

displayed. All settings you select for the forum will be inherited by any topics created within 
that forum.  

3. Enter Forum Title, Short Description (Optional), Description (Optional). To add an attachment 
for participants to read, click Add Attachment and follow the prompts. 

4. Forum Posting – set posting options 
• Lock Forum (Disable forum postings) – students can still read, but they cannot post 
• Moderate Topics in Forum – selecting this requires a moderator to approve all posts 

before they are visible to students. 
• Require users to post before reading – students cannot read other posts until they have 

posted themselves. When users initially access the topic, they will see the following 
message: 

 
5. Availability Select when the forum will be displayed to site participants  

• If you want the forum to be displayed immediately and not be hidden at a later date, 
click Show immediately. 

• If you want to set a date for when the forum is displayed and/or hidden, click Specify 
Dates. Then, enter the appropriate dates in the Open Date and Close Date fields that 
are displayed. Note students will not be able to read posts after the Close Date.  

6. Automatically Mark All Messages in Conversations Read – makes marking individual messages 
as read unnecessary.  

7. Grading - Associate this forum with a specific pre-existing item in the Gradebook by selecting 
from the Gradebook Item pulldown list. In order to do this, you’d have to first create a 
gradebook item so the item will show up in the pulldown menu. Note:  You may not want to 
associate a forum with a gradebook item, but instead, you may want to do so when you’re 
setting up a topic. 

8. Permissions – set permissions for each role or group.  Use drop-down to select one of the 
default permission levels, or click Customize and select/deselect permission items. 

9. Click Save or another appropriate option. 

 
Warning:  Site participants cannot view or access a forum until it has at least one topic in it. Even so, 
you do not necessarily have to add the first topic when you create the forum. You may add a topic 
when you create the forum or at any future time. 

Changing a Forum 

1. Find the appropriate forum and click the Forum Settings link for it.  
2. Change entries as desired and exit from the screen as appropriate.  
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Deleting a Forum 

Warning: When you delete a forum, you also delete all topics and messages in it. 

1. Find the appropriate forum and click the More link for it.  
2. Click the Delete Forum link from the menu.  
3. To proceed to delete the forum and its contents, click the Delete Forum button; to abandon 

this action, click Cancel. 

Setting up and Managing Topics 

Adding a Topic 

1. Find the forum to which you want to add the topic and click the New Topic link. 
2. Enter Topic Title, Short Description (Optional), Description (Optional). To add an attachment 

for participants to read, click Add Attachment and follow the prompts. 
3. Topic Posting 

• Lock Topic (Disable topic postings) – students can still read, but they cannot post 
• Moderate Topic – selecting this requires a moderator to approve all posts before they 

are visible to students.  
• Require users to post before reading – students cannot read other posts until they have 

posted themselves 
• Posts are anonymous –  users will not see author information. If this option is selected, 

another option will be shown which allows permissions to be adjusted for who can see 
author information.  

4. Availability Select when the topic will be displayed to site participants  
• If you want the topic to be displayed immediately and not be hidden at a later date, click 

Show immediately. 
• If you want to set a date for when the topic is displayed and/or hidden, click Specify 

Dates. Then, enter the appropriate dates in the Open Date and Close Date fields that 
are displayed. Note students will not be able to read posts after the Close Date.  

5. Mark All Messages in Conversations Read – makes marking individual messages as read 
unnecessary.  

6. Grading - Associate this topic with a specific pre-existing item in the Gradebook by selecting 
from the Gradebook Item pulldown list. In order to do this, you’d have to first create a 
gradebook item so the item will show up in the pulldown menu.  

7. Permissions – set permissions for each role or group.  Use drop-down to select one of the 
default permission levels, or click Customize and select/deselect permission items. 

8. Click Save or another appropriate option. 

Changing a Discussion Topic 

1. If the Forums home page is not displayed, click FORUMS in the breadcrumb bar. 
2. Find the appropriate topic and click the Topic Settings link for it.  
3. Change entries as desired and exit from the screen as appropriate.  
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Deleting a Discussion Topic 

Warning: When you delete a topic, you also delete all messages in it. 

1. If the Forums home page is not displayed, click FORUMS in the breadcrumb bar. 
2. Find the appropriate topic and click the More link for it.  
3. To delete this topic, click the Delete Topic link in the pop-up menu.  
4. To proceed to delete the topic and its contents, click the Delete button near the bottom of the 

screen again. Or, to return to the Forums home page without deleting it, click Cancel. 

Changing the Order of Forums and Topics 

By default, the most recently created forums and topics are listed first on the home page. To change the 
order of forums or topics on that page, access the Forums tool and follow these steps:  

1. If the Forums home page is not displayed, click FORUMS in the breadcrumb bar. 
2. Click the Organize tab. 

 
3. The title of each forum and topic is preceded by a pulldown list that shows the order in which 

the forum or topic is displayed. 
4. Use the pulldown lists to change the order. 
5. To save your work, click Save. 

Grading Student Work in the Forums Tools 

The Forums tool allows you to choose whether or not to grade each forum or topic you create. 
When you want to grade a forum or topic, it is a good idea to choose a default gradebook item 
from the dropdown menu in the settings.  You will need to create the item in the Gradebook 
tool before being able to select an option here (Refer to the Gradebook Help Documents for 
how to create Gradebook Items). 

Once you have posted the forum or topic, you can grade each student’s post individually, giving 
both a grade (in number of points) and comments. 
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Statistics 

Once you have all of your forums set up, you can track how much your students are reading 
and posting. Note that the Read/Unread statistic is only accurate if students actually mark posts 
as read.  

 

 Grading by Forum 

1. On the Forums home page, click the More link for the appropriate forum. 

2. From the displayed menu, select Grade. ReggieNet displays a Statistics & Grading page for 
that forum. 

3. By default, the Statistics & Grading by User is selected in ReggieNet. 
4. On the Statistics & Grading page, you can view all messages a student has authored in the 

forum by clicking on the appropriate student’s name.  

 
4. To grade participation in the Forum, click on Grade.  
5. On the top right of the Statistics & Grading area, choose a gradebook item to associated the 

forum to by using the Select a gradebook item menu. 

 

Select a Gradebook 
Item Menu 

Grading by User 
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6. After selecting a 
Gradebook item, the 
Statistics & Grading 
page now provides 
boxes for entering 
grades for course 
participants. 
 

 

7. Click on Show Comments to 
open text boxes that allow 
for entering 
comments/feedback if you 
wish to provide 
comments/feedback to 
course participants.   
 

8. Enter scores and comments in the appropriate fields. To apply one score to all students 
without a grade, enter the score in the displayed field and click Apply Grade to all 
Ungraded. Lastly, click Submit Grades. 

 

Grading by Topic  

1. From the Forums tool home page, access the Statistics & Grading page for that topic. You 
can do so in one of two ways: 
• Click the More link for the topic. From the displayed menu, select Grade. 

OR 
• In the tool menu bar, click Statistics & Grading. Then, click Statistics & Grading by 

Topic. From the list of topics in the topics column, click on the appropriate topic.       

2. In either case, ReggieNet displays a Statistics & Grading page for that topic.  
 

Grading by Topic 

Topic Column Forum Column 
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3. Grade participation in the topic by clicking on the Grade link for each student. You may only 
enter grades as points, and only to the maximum allowed for the associated gradebook 
item. Enter scores and comments in the appropriate fields. To apply one score to all 
students without a grade, enter the score in the displayed field and click Apply Grade to all 
Ungraded. Lastly, click Submit Grades. 

Grading by Student 

On the Statistics & Grading page, you can view all messages a student has authored that are 
associated with a topic within a forum by clicking on the appropriate student’s name. 

  

You can then click on the Grade link to enter a grade.  

Grade Link 
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Participating in a Discussion 

Reading Messages 

1. Display the desired Forum by 
clicking its name in the forums list 
on the home page; then click the 
name of the desired Topic in the 
resulting display. You may sort 
the list by subject, author, or 
date. 

 
2. Next to the subject, the display indicates 

the number of messages in the thread. 
Threads that contain replies show the 
replies indented. Messages that are new 
and any that have not yet been 
approved by the moderator are flagged 
as “New” and “Pending,” respectively. 
An envelope icon also displays next to 
the name of the person who has posted 
a new message. 

Posting a Reply 

1. Click the  link for it.  
2. The Reply Title box contains a default title for your reply. This title is in the format Re: [subject 

of thread or message to which you are replying]. 
3. If desired, change Reply Title entry. This box is required. 
4. If desired, insert the text of the message to which you are replying by clicking the Insert 

Original Text button. ReggieNet copies the text of that message and the name of its creator 
and creation date and time into the Message box. 

5. In the Message box, enter your reply. Use the icons and boxes to format the text as 
appropriate.  

6. If desired, display the number of words in the message by clicking the Count words link.  
7. To add one or more attachments to this message, click the Add attachments button. 
8. To post the message, click the Post Message button near the bottom of the screen.  

Changing a Message 

As the instructor, by default, you have an option to edit any messages. 
1. Beneath the poster’s name, click the Edit link for the message you want to change.  
2. Edit as desired. 
3. Click on Post Edited Message,  

Forum 

Unread 
Message Flag Topic 
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Deleting a Message 

As the instructor, by default, you have an option to delete any messages. 
1. Beneath the poster’s name, click the Delete link for the message you want to remove. 
2. ReggieNet asks you to confirm that you want to delete the message, click the Delete button. 

Watching Forums 

1. If the Forums home page is not displayed, click FORUMS in the breadcrumb bar.. 
2. Click the Watch tab near the top.  
3. The system displays this screen: 

 
4. Choose one of the following options: 

• To receive an email each time a new message is posted, click Send me an email whenever a 
new message is posted.  

• To receive an email only when a new message has been posted to a thread you have 
contributed to, click Send me an email when a converation that I have contributed to receives 
a new message. 

• To stop receiving notifications via email, click No notification.  
• To save your changes, click the Save button. 

Creating Group Discussion 

You need to first create groups using the Manage Groups function in the Site Info tool. 

Creating Groups 

1. Click Manage Groups 
2. Click Create New Group 
3. Enter Group Title 
4. Click student name(s) and click the > button to move the students to the Group Member List 
5. Click Update 

Creating Auto Group 

1. Click Manage Group 
2. Click Auto Groups 
3. Click on the check box labeled “Students” 
4. Select Create random groups from members with the selected role. 
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5. Select Split by number of groups needed or Split by number of users needed per group and 
provide required information. 

6. Click Update 

Creating Group Discussion 

1. Before you start a new topic, please create a new forum for the group discussions.  In the Forum 
Setting, under the Permission setting, make sure that the Students role has NONE on the 
permission level. 

2. Create a Discussion topic by clicking New Topic 
3. All the options are the same as you’d create a new topic for the whole class, but when you’re 

creating group discussion topics, go to Automatically Create Topics and select “Automatically 
create multiple topics for groups”. 

4. Select the boxes for groups. 
5. Click Save.  This will automatically create the same topic for each group. 

Chat Room 

The Chat Room tool allows you to exchange text messages in real time with other site participants who 
are currently online. These online conversations offer a forum for getting to know other site 
participants, holding office hours online (assuming you do not need privacy for a meeting), providing 
tutoring, answering simple questions, and helping with homework. A chat room may also provide a 
vehicle for you and other team members to meet with an expert in a remote location, allow members of 
a study group to exchange information, and hold other real-time, unstructured conversations with users 
who are signed on at the same time.  

 
Warning: Chat Room messages are not private. All users who are online and have read permissions can 
view them. ReggieNet saves chat messages indefinitely, but an instructor may choose to limit the time 
period for which chat messages are displayed, clear the entire history, and may delete individual 
messages from the site.  
 
The Chat Room tool has the following important features.  

• Multiple active chat rooms: You may maintain one or more active chat rooms and change the 
room you are viewing at any time.  

• Flexible default chat room: You may set any chat room as your default room and may change 
this default at will.  

• Users present list: Users can see a list of other users who are currently on line in the site.  
• Display options: Instructors can specify the number of messages that are displayed to all 

participants or can allow participants to control the display on their own screens. All participants 
can control the date/time display.  

• With appropriate permissions, site owners may clear the history for any chat room.  
• Archiving: All messages are archived indefinitely, until you delete them.  
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Posting Chat Messages  

1. If the Chat Room home page is not displayed, click CHAT ROOM in the breadcrumb bar.  
2. Enter message text in the large white box at the bottom of the screen.  
3. To post your message, click Add message. To erase the message without sending it, click Clear. 

After you click Add message, ReggieNet displays the message beneath any older messages in 
the display.  

Deleting Chat Room Messages  

In general, participants may delete their own messages, while instructors, co-instructors and Teaching 
Assistant may delete any messages.  

1. Click the trash can icon next to the message you want to delete.  
2. Click Delete or Cancel.  

Adding a Chat Room  

Tip: Some browsers have difficulty displaying more than 35,000 characters on a single web page. The 
longer a chat becomes, the more difficult it can be for a user to show all messages. To improve 
performance, you may wish to create a new chat room or archive an older chat room by cutting and 
pasting the messages into a Word document and posting it to an appropriate folder in the Resources 
tool.  

1. Click the Options button on the Chat Room menu bar. ReggieNet displays the Manage Rooms 
screen.  

2. Click the Add Room tab. ReggieNet displays the Add Room screen.  
3. Enter Title and Description (optional) .  
4. Under the Recent Chat Display section, click a radio button to specify the number of messages 

or days worth of messages you want to display by default. If appropriate, specify the number of 
messages or days worth of messages to display.  

5. To allow participants to change the number of days or messages you have specified, check 
Allow chat participants to change the chat display settings for their own chat window.  

6. Enter Start or  End dates if you wish to restrict access by date.  
7. Click Update options or Cancel. 

Editing Information about a Chat Room  

1. Click the Change Room tab. ReggieNet displays the Manage Rooms screen.  
2. Find the name of the chat room you want to change and click the Edit link under its name. 

ReggieNet displays the Edit Room screen.  
3. Change the Title and Description (optional) .  
4. Under the Recent Chat Display section, click a radio button to specify the number of messages 

or days worth of messages you want to display by default. If appropriate, specify the number of 
messages or days worth of messages to display.  

5. To allow participants to change the number of days or messages you have specified, check 
Allow chat participants to change the chat display settings for their own chat window.  
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6. Click Update options or Cancel. 

Viewing Another Chat Room  

If more than one chat room has been set up for your site, you may change the chat room you are 
viewing at any time. To do so, follow these steps:  

1. Click the Change Room tab tab.  ReggieNet displays the Manage Rooms screen.  
2.  Click the name of the chat room you want to view. ReggieNet displays messages for that chat 

room on the home page.  

Changing Your Default Chat Room  

If more than one chat room has been set up for your site, you may change your default chat room at any 
time. To do so, access the Chat Rooms tool and follow these steps:  

1. Click the Change Room tab. ReggieNet displays the Manage Rooms screen.  
2. Find the name of the chat room you want to set as the default, and click the Set as Default link 

under this name. ReggieNet makes this room the new default and displays the Set as Default 
link under the name of the other chat rooms.  

3. To display the new default chat room, click the Back to room button.  

Clearing History for a Chat Room  

If you are a site organizer or instructor, you may clear the entire history for a chat room (that is, delete 
all messages in the room).   

1. Click the Options tab. ReggieNet displays the Manage Rooms screen.  
2. Under the name of the appropriate chat room, click Clear History. ReggieNet displays a delete 

confirmation message asking if you want to delete all messages from this chat room.  
3. To proceed, click the Delete button. Or, to exit without clearing history, click Cancel.  

Polls  

If you are an instructor or site owner, the Polls tool allows you to conduct anonymous voting. The tool 
has the following features.  

• Each poll contains a single question. For conducting polls containing multiple questions, consider 
using the Tests & Quizzes tool instead. For more information on that tool, see Tests & Quizzes.  

• Users may vote once per poll.  
• You may enter any number of answer options for a question and may specify how many or few 

options each user may choose. You may also allow a user to choose none of the options.  
• You control the display of results to site participants.  

Adding a Poll  

1. Click the  Add tab.  
2. Enter Questions and Additional Instruction (optional). 
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3. Specify an opening and closing date and time for this poll. Use the Calendar icons to make 
selections, if desired.  

4. In the Limits section, use the pulldown lists to select the minimum and maximum number of 
options each user can select when answering the question. To restrict users to a single answer, 
use the default entry of 1 in each pulldown list.  

5. In the Results are visible section, click a radio button to indicate your preference as to when, if 
ever, results will be displayed to site participants. Note the following:  

• Choosing “always” makes the results available to all, even those who have not yet 
voted.  

• Choosing “to participants who have voted, or after closing date” makes the results 
available to all, even those who have not yet voted, but only after the closing date.  

6. To save the question and continue, click the Save and add options button. ReggieNet displays 
the Add an Option screen. Or, to cancel your work and return to the home page, click Cancel.  

7. Enter the text of an answer option in the box.  
8. Choose one of these options:  

• If you have entered all desired answers for this poll, click the Save button. ReggieNet 
displays the Add a Poll screen again, complete with the text of the question and answers 
you have entered. 

• To save this answer and add another answer option, click Save and add options.  
• To exit without saving your work on this screen, click Cancel.  

9. Assuming that you are continuing your work on this poll, review the question, answer options, 
and other information shown on the Add a Poll screen and then click Save.  

Editing a Poll  

1. Find the poll you want to change and click the Edit link beneath the question.  
2. Make changes to the question text, additional instructions, dates, limits, and results display 

options as desired.  
3. If desired, change the answer options in any of these ways:  

• To add another option, click the Add option link under the Options section heading.  
• To change an option, click the Edit link to the right of the option text and proceed. 
• To delete an option, click the Delete link to the right of the option text and then click 

Remove when ReggieNet displays the delete confirmation screen.  
4.  Review the changes you have made. If they are as expected, click Save. 

Deleting a Poll  

1. Find the poll you want to change and click the Remove box to the far right of the question.  
2. Click the Update button near the bottom of the screen. ReggieNet deletes the poll 

immediately.  

Voting  

1. Find the poll you want and click the question. ReggieNet displays the Vote screen. Note the 
following: 
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• If only one answer can be selected, ReggieNet displays a round radio button to the left 
of each answer.  

• If multiple answers can be selected, ReggieNet displays a square check box to the left of 
each answer. You will not be allowed to select more than the maximum number of 
answers permitted.  

2. Click the option(s) that best express your opinion.  
3. Click the Vote! Button or another appropriate option. 

Displaying Poll Results  

Find the poll you are interested in and click the Results link to the right of the question. ReggieNet 
displays the Results screen.  

 

Blogs 

With the Blogs tool, you may:  

• Create blog posts viewable by all members of the site, or admins only.  
• View and leave comments for the blog entries of other users. 
• Receive comments on your blog entries from other users, as well as leave your own comments. 
• Add RSS news feeds for the blogs of other users, as well as for your own.  

If the Blog tool is not already added to your site, you can add it through Site Info > Manage Tools. 

Accessing the Blogs Tool 

You’ll see a list of the blogs that other site participants have created and to which you have access, along 
with the number of blog entries for each blogger and the date and time of their most recent activity. In 
addition, ReggieNet displays an RSS feed icon for each blog. 

ReggieNet also displays 
the My blog link, for 
access to all of your own 
blog entries, as well as 
the date and time of 
your last activity.  

 
 
 
 
Viewing and Managing Your Blog Entries 

1. Click the All the blogs tab at the top of the page.  
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2. Click the My blog link. ReggieNet displays a page similar to this one:

 
3. On this page, you may view all of your blog entries, both published and in draft mode. You may 

also take a variety of actions: 
• To edit an entry, click the Edit entry link. 
• To remove an entry, click the Remove entry link 
• To view comments for a blog entry, click the comments link. 
• To leave a comment for an entry, click Leave a comment 

Adding a Blog Entry 

1. Click the Add blog entry tab. ReggieNet displays the Add a new blog entry page. 
2. In the Title box, enter a title for the blog entry. An entry here is required. 
3. In the text box, add your content. An entry here is required.    
4. Specify who may view your blog entry.  

You can choose to make your post 
available to site administrators 
(Instructors) only; all members of the 
site; or public. Note:If you select This 
entry is publicly viewable, you must still 
provide the entry’s URL to users. 

5. If you want to publish your blog entry, click Publish Entry. If you want to save your work but do 
not want to publish the entry, click Save Draft. If you do not want to save your work, click 
Cancel. 
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Editing a Blog Entry 

1. If the main page for the Blogs tool is not displayed, click BLOGS in the breadcrumb bar and click 
the All the blogs tab at the top of the page. 

2. Click the My blog link. 
3. For the appropriate blog entry, click the Edit entry link. ReggieNet displays the Edit a blog entry 

page. 
4. Make all appropriate changes to the entry’s content and/or settings. 

Removing a Blog Entry 

1. If the main page for the Blogs tool is not displayed, click BLOGS in the breadcrumb bar and click 
the All the blogs tab at the top of the page. 

2. Click the My blog link. 
3. For the appropriate blog entry, click the Remove entry link. Click OK in the pop-up dialogue box 

that appears. Or, if you do not want to remove the entry, click Cancel 
 

Viewing Blogs of Other Users 

1. If the main page for the Blogs tool is not displayed, click BLOGS in the breadcrumb bar or click 
All the blogs in the Blogs menu bar at the top of the page. 

2. From the Blogger column, click on the appropriate name. ReggieNet displays that user’s blog. 
You’ll see all the blog entries to which you have access, with the most recent entry on top. 

3. To view comments left by other users, click on the comments link, which includes the number of 
comments. To see a blog entry in a separate window, click the Permalink link.    

4. Depending on the permissions you’ve been granted, ReggieNet may also display a Leave a 
comment link for each entry.  

Leaving Comments for Blog Entries 

If the site owner has granted you the appropriate permission, you may leave a comment for a blog entry 
by another user. To leave a comment, follow these steps: 

1. For the appropriate blog entry, click on the Leave a comment link. ReggieNet displays the 
existing comments for the entry, along with a box for leaving your own comment. 

2. Enter your comment in the box and click Publish comment. Or, click Cancel to leave no 
comment.  

Adding an RSS feed for a Blog 

To add an RSS feed for a blog, follow these steps:   

• If the home page is not displayed, click the Reset button or click All the blogs in the Blogs menu 
bar at the top of the page. 

• For the appropriate user, click on the RSS icon at the right of the page. ReggieNet displays a 
separate window, where you may select an RSS subscription option. 
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Sign-up 

 
The Sign-up tool lets instructors schedule, and students to sign up for, a variety of events, 
such as office hour visits, review sessions, and study groups.  
 

 
 

Accessing the Sign-up Tool 
 
On the home page of Sign-up, you may: 
 

• View the title, organizer, location, date and time, and status of each meeting. 
• Click on a meeting title to modify, copy, export, or print that meeting. 
• Filter the list of meetings by using the View dropdown menu. You may select all 

meetings, all future meetings, meetings scheduled in the next 30 or 90 days, 
meetings available for sign up, or meetings for which you have signed up. 

• Remove a meeting, by clicking on the appropriate checkbox and clicking the 
Remove Meetings button. 

• View each occurrence of all recurring meetings, by clicking the checkbox for Expand 
all recurring meetings, or view each occurrence of a specific recurring meeting, by 
clicking the “+” icon next to its title. 

• Add a new meeting, by clicking the Add tab. 
• Export all or selected meetings, by clicking the Export tab. 
• Change permissions for using the Sign-up tool, by clicking the Permissions tab. 

Adding a Meeting 
 

1. Click the Add tab. The Create New Meeting: Basic Information page is 
displayed. 
 

2. Provide meeting information, organizer, location, and time. 
 

• In the Title field, enter a title for the meeting. This information is required. 
 

• From the Organizer menu, optionally select an organizer for the meeting. If 
you’re the site owner, you will be the meeting organizer by default, but you may 
also choose another user as an organizer. (Note: only users with the appropriate 
permission will be displayed in this menu.) 
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• Provide a location for the meeting. If you have already added meetings, you 
may use the dropdown menu to select from previously entered locations. Or, you 
may enter a new location. This information is required. 

 
• Include additional information for the meeting, by entering a name in the 

Category field, using the rich text editor, and adding attachments. 
 

• Using the displayed fields, dropdown menus, and calendar icons, select a 
start/end time and date for the meeting. This information is required. 

 
Instructor’s screen 

 

 
 

Student screen 

 
 



Communication Workshop 8/3/18 Page 19 

Changing Information and Settings for a Meeting 
 
1. On the Sign-up tool home page, find the meeting and click on its title.  
2. Click on Modify in the menu bar at the top of the page.  
3. If the meeting is recurring, you’ll see a Modify Options section at the top of the page. 

By default, the Modify all future recurring meetings setting is selected. Make all 
necessary changes.  

4. Click Publish Modification to save your changes. 
 
 
Tips on Communicating with Students in ReggieNet  

Since ReggieNet generally does not indicate new content, you may want to use the notification features 
in various tools or have students set them up on their end. 

When you are setting up a new item or editing an item in any of the following tools, you have an option 
to send e-mail to students from the tool. 

• Syllabus 
• Announcements 
• Resources 
• Drop Box  

Additionally, the following communication tools have features that students might want to pay 
attention to or set up an option on their end. 

Forums – all new messages are displayed in MyWorkspace and the course site Homepage.  The Watch 
feature in this tool will notify students when there is a new message for the threads they set to “watch.” 

Messages – Under Settings, students and instructors can set an option for “Auto Forward Messages.”  
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